
UNIT – V 

NETWORKING 

GENERAL 

Society is shaped by sudden growth and development of the information technology (IT) resulting 

with its great dependency on the knowledge and competence of individuals from the IT area. 

Although this dependency is growing day by day, the human right to education and information is 

not extended to the IT area. Problems that are affecting society as a whole are emerging, creating 

gaps and distancing people from the main reason and motivation for advancement-opportunity. 

Being a computer illiterate person today means being a person who is unable to participate in 

modern society, and a person without opportunity; and despite the acknowledged necessity and 

benefits of inclusive computer literacy from institutions like the European Commission, UNESCO, 

OECD, there are still groups of people having difficulties accessing basic computer education viz. 

persons with disabilities, persons with learning difficulties, migrant workers, unemployed persons, 

persons that live in remote (rural) areas where IT education is not accessible. 

DEFINITIONS AND TERMS  

• Internet – set of millions of computers worldwide connected into a network with the purpose of 

exchanging data among users  

• WWW - World Wide Web – one of the services on the Internet which we use to browse web pages 

(set of HTML documents connected with hyperlinks)  

• HTTP – Hypertext Transfer Protocol – protocol (set of rules) that allows transmission of 

information published on the Web  

• URL – Uniform Resource Locator - Web address of a particular object (Web pages, images, or Word 

or PDF document) published on the Internet  

• FTP – File Transfer Protocol – protocol that allows data transfer between computers over the 

Internet  

• Hyperlink or link - part of the text or graphics on a web page; when we activate a hyperlink (click 

on it), it takes us to: o another part within the same web page o another website  

• Web address element 

Web address elements – for example http://www.google.hr o http: - protocol (rules of transmission) 

o www – a type of service available on the Internet o Google – a domain name (computer) o .hr – 

top–level domain (ccTLD - Country code top-level domain)  

• Domain: - electronic identification on the Internet o commercial (.com, .net, .biz)  international 

(.hr, .si, .it, .de…) o non-commercial (.edu, .mil, .gov)  

• Web browser o software (program) which allows us to browse web pages o the most widely used: 

Google Chrome, Mozilla Firefox, Opera, Internet Explorer  

• Web search engine o contains content categorization of many Web pages o after one enters the 

desired term, search engine will search the Web and display results (web pages, images, documents) 

that are the most relevant for the entered term o www.google.com , www.pogodak.hr , 

www.yahoo.com, www.bing.com  

http://www.bing.com/


• Cookie - text file stored on our computer by web page to facilitate communication between your 

computer and the website’s server  

• Cache - a folder on the hard disk which stores all objects visited on the Web o provides: - faster re-

loading of pages - reading web pages in offline mode (while not connected to the Internet)  

• Internet Service Provider (ISP) – a company that provides Internet access for its users.  

• Really Simple Syndication (RSS) – facilitates the possibility of information (news, blog entries, etc.) 

transfer published on a web page in a standardized manner (usually the title, a sentence or two of 

the article, a link to a page that contains the whole article). Subscribing to site’s RSS feed allows 

users to receive updates from that website without going to the site itself • Podcast - Digital files 

containing audio or video recording. 

SAFETY  

• access to some sites is granted only to the users who have the necessary username and password 

• identifying a secure web place: web address begins with „https“; look out for the lock symbol in 

the Address bar  

• Digital Certificate - converts data into a code to protect it from abuse (credit card number, for 

example)  

• Encryption - protection – a way to convert data into a format such that the person with a way to 

unlock it can read it, others cant. Used by most email service providers to ensure protection of 

emails over the internet.  

• Malware: Computer virus, Worm, Trojan horse, spyware  

• Spyware – a spy program installed to the computer over the Internet used to send our private 

information to the author o It is recommended that you install an anti-spyware program such as Ad-

aware, Spybot Search & Destroy  

• downloading files from the Internet has its risks, therefore it is recommended to: o share files only 

with the people you know and trust o use up-to-date antivirus software o do not open e-mail 

attachments received from unknown sources  

• dangers of leaving (personal) data on the internet o sharing your e-mail address on the Web 

exposes you to spam o possible theft of credit card numbers used for Internet purchase  

• dangers related to online activities are: inadvertent disclosure of personal data, threats or 

annoyance, predators attacks  

• programs that allow parental control through: o monitoring visited websites, o web browsing 

restrictions, o setting limits to video games, and o limiting the time spent using the computer  

• Firewall o program that controls and protects the ports, allowing only authorized attempts to enter 

o Windows Firewall was first released as a part of Microsoft Windows XP Service Pack 2 (SP2) 

 

USING A WEB BROWSER (Internet Explorer 8)  

• installed browsers are listed in the Start menu, to start one needs to left-click on the program icon 

• it is opened in the window with the following elements:  



1. Sizing buttons – minimize, maximize, close the window  

2. Title bar – web page title and the name of the program (IE8)  

3. Menus: o File o Edit o View o Favorites o Tools o Help  

4. Address bar  

5. Command bar o some commands are hidden, clicking an arrow next to it opens extra options o 

grayed out commands are currently unavailable o three-dot commands have a sequence of further 

commands  

6. Scrollbar  

7. Status bar - shows the loading percentage of web page 

 

USING THE WEB  

Completing web forms on the Internet  

• moving through text boxes – using Tab key or left-click on the Text Input field  

• press Submit button to confirm the text entry Browsing the web using search engines  

• type in keywords, the search engine will show a list of matching results (hits)  

• the most popular search engines: o Google http://www.google.hr o Yahoo http://www.yahoo.com 

o Bing http://www.bing.com o MSN http://www.msn.com  

• entering terms into the search engines o if the term has more than one word, it is important how 

you enter it:  White house – search by separate words  “White House” – search the exact phrase 

that is within the “” over the internet o for more efficient use of search engines is to enter fewer 

words that precisely describe what you need  

• search a web based encyclopedia (e.g. Wikipedia) and/or dictionary (e.g. Thesaurus 

• use advanced search features to refine a search: by exact phrase, excluding words, by date, 

by file type, etc. 

 

ELECTRONIC COMMUNICATION  

• SMS - Short Messaging Service – communication service that allows sending short text messages 

(up to 160 characters) over the phone  

• there are services on the Internet that offer - real time communication, knowing whether contacts 

are online, low cost, ability to transfer files: o Instant Messaging – (IM) - Google Talk (now called 

Google Hangouts), Yahoo! Messenger o Voice over Internet Protocol –(VoIP) – allows transfer of 

voice communication over the Internet, in most cases - free computer to computer phone calls and 

cheaper phone calls from computer to mobile phone and landline Virtual community  

• social networking websites: Facebook, Bebo, Twitter; MySpace, LinkedIn, Nexopia, Hi5, Tagged, 

XING, Orkut etc.  

• Internet forums – Forum.hr, Net.hr, Download.hr, Index.hr etc.  

http://www.msn.com/


• chat rooms  

• multiplayer games: Anarchy Online, Guild Wars, World of Warcraft etc. 

 

E-mail  

• transfer of textual messages, through which documents from any program can be sent, except the 

executive programs (extension: .exe)  

• structure of the e-mail address: user name, @ symbol and a domain name (name of the computer 

on the Internet where mail will be delivered to the recipient), for example ivana.majic@gmail.com , 

c3po@vip.hr  

• e-mail advantages: fast (instant) delivery, low cost, flexibility of using mail account on websites  

• netiquette (network etiquette): use precise and short message titles, check your e-mail so you can 

respond quickly, check spelling and grammar, do not use capital letters (seen as an equivalent of 

speaking loudly).  

• leaving your e-mail address on the Internet increases the possibility of getting unsolicited mail 

(spam). Be careful about which websites you give your email address to avoid spam.  

• when you're opening messages or attachments to messages from unknown sources you are 

exposing your computer to virus infection; it is necessary to have antivirus program installed  

• phishing – type of fraud where false web sites attempt to acquire confidential information (credit 

card numbers, user data, passwords, etc.), usually an identical copy of a well-known bank's webpage  

• digital signature - ensures that the message hasn't been changed on its way from the sender to the 

receiver and guarantees the identity of the sender. 

 

WORKING WITH E-MAIL SENDING AN E-MAIL  

• create a new e-mail: click on the New icon (if you are in Inbox, Outbox, Sent items or Deleted 

items)  

• enter an e-mail address: type it in or choose it from contacts list by clicking the To button  

• CC (Carbon Copy): sending a copy of a message to secondary recipients – visible to other recipients  

• BCC (Blind Carbon Copy): sending a copy of a message to secondary recipients – hidden from other 

recipients. This means, that the people you send out the email to wont be able to see the other 

people you’ve sent the email.  

• Subject – state briefly and clearly what it is about (netiquette)  

• Accounts – if there are multiple accounts, choose an account from which you are going to send the 

e-mail 

• Insert: a possibility to attach files and/or insert images or hyperlinks into the message  

• quickly insert a file and item (object) from Outlook using a paperclip icon  

mailto:c3po@vip.hr


• it is recommended that you compress large attachments using WinZip, WinRar or similar 

programs 

 

 

MAIL FORMAT  

• before sending an e-mail, set the mail format: open the Tools menu, select Options, select Mail 

Format o HTML o Plain text – without formatting, faster sending and receiving o Rich Text – supports 

additional formatting  

• signatures – we can add a permanent signature  

• spelling – we can set the language for which Outlook will do the spell check  

• save a draft of an e-mail: if you want to continue with formatting and sending the message later – 

close the message window and save changes when the dialogue box appears; message is saved in 

drafts The process of sending e-mail  

• possibility of sending messages with low or high priority  

• when you have finished the editing, press Send button, the message goes to Outbox o the 

messages from the Outbox are automatically sent after a period of time which is set in Tools, 

Options, Mail Setup, Send/Receive, or o manually – when we press Send/Receive button on the 

Toolbar  

• after the message is sent, it goes to Sent items Working with Inbox  

• after pressing the Send/Receive button, messages from Outbox are sent to recipients and new 

messages from server are coming to Inbox  

• unread messages are highlighted with a bold font  

• all messages can be sorted in ascending or descending order based on few categories: leftclick on 

column header – all messages in that folder are sorted according to the selected criteria (Title, 

From...) Saving, moving, deleting messages  

• select: using the Shift key for selecting multiple messages that are in a row and the Ctrl key for 

multiple messages which are not consecutive  

• move: drag and drop - press and hold down the left mouse button on a message, drag it to desired 

folder, drop it by releasing the mouse button – message is moved to a folder  

• delete: select the message and press the Delete key  

• save a message: select Save As on the File menu, type in the name and select the location where 

you want to save the message 

Replying and forwarding messages  

• replying to a message: Reply button– prefix “Re:“ is added to the title of the message as well as to 

the title of the received message  

• forwarding a message: Forward button, prefix “Fw:“ is added to the title of the message  



• Outlook automatically puts the original message text in the replied or forwarded message. To turn 

it off: Tools -> Options -> E-mail Options, then choose "Do not include original message"  

• forwarding a message retains attachments; replying to a message automatically removes the 

attachment  

• flagging a message – further actions with the message are expected  

• marking messages as unread: right-click the message, select Mark as unread  

• show/hide a toolbar: View menu, select Toolbars option (Toolbars that are marked with a check 

mark are displayed) 

 

HISTORY OF WEB BROWSERS  

• The history of the Web browser dates back in to the late 1980s, when a variety of technologies laid 

the foundation for the first Web browser, WorldWideWeb, by Tim Berners-Lee in 1991.  

• Microsoft responded with its browser Internet Explorer in 1995 initiating the industry's first 

browser war  

• Opera first appeared in 1996; although it have only 2% browser usage share as of April 2010, it has 

a substantial share of the fast-growing mobile phone Web browser market, being preinstalled on 

over 40 million phones.  

• In 1998, Netscape launched Mozilla 

 

TYPES OF WEB BROWSER  

• Amaya   • Internet Explorer  

• AOL Explorer   • Internet Explorer for Mac  

• Elinks   • Internet Explorer for Mac  

• Arlington Kiosk  • Konqueror  

• Dillo    • Links  

• Epiphany   • Lynx  

• Flock    • Mosaic  

• Galeon   • Maxthon  

• iCab    • Mozilla  

• K-Meleon   • Mozilla Firefox  

• KioWare   • Netscape 

 

WORLD WIDE WEB 



WorldWideWeb was the first web browser. When it was written, WorldWideWeb was the only way 

to view the Web  

It was capable of displaying basic style sheets, downloading and opening any file type supported by 

the NeXT system, browsing newsgroups, and spellchecking. At first, images were displayed in 

separate windows, until NeXTSTEP's Text class supported Image objects. 


